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Getting Started

Read This First!

You Need a Personal Computer With a USB Port

MX-3000 Editor will run on any Pentium Il or faster Windows PC. Your PC should be equipped with an adequate
amount of RAM for the operating system you use. MX-3000 Editoris compatible with the Windows 98, ME, 2000, XP
and XP Pro operating systems. It is not compatible with Windows 95 or previous versions of Windows.

MX-3000 Editor is installed via a self extracting installer file downloadable from www.hometheatermaster.com. You

need a connection to the internet to download the file or to update MXEditor.

Installing MX-3000 Editor and Microsoft ActiveSync

MX-3000 Editor installs with a companion program for communication, Microsoft ActiveSync.You must install both
programs. To install the two programs, follow these steps:

I Connect to the internet and go to this website address:
http://www.hometheatermaster.com/mxeditor/downloads/mx-3000setup.exe

2 A file download window will open. Click on OPEN.

3 The InstallShield Wizard window for MX-3000 Editor will open. Click on NEXT

i'-.%l' MX-3000 Editor - InstallShield Wizard 5'

Welcome to the InstallShield Wizard for
¥x-3000 Editor

The Installshield{r) Wizard will install 1Mx-3000 Editor on wour
computer, To continue, click Mext,

WWARMIMG: This program is protected by copyright: law and
international kreaties,

= Bach I Mext = I Cancel |

4 The Install Destination window will then open. Click on NEXT.
5 The Ready to Install window will open. Click on INSTALL.
6 The program will install and then show that installation has been completed. Click on FINISH.

7 A new small window will open asking, "Install the Microsoft Active Sync 3.7." Click OK.

mstall

Install the Microsoft Ackive Sync 3.7

oK I Cancel |

HOME THEATER MASTER
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Getting Started

8 A new set up window will open for ActiveSync 3.7. Click on NEXT.

osoft ActiveSync

Set Up Microsoft® ActiveSync® 3.7

@ Before you can exchange information between your mobile

device and this computer, you must set up ActiveSync.
Thig zetup wizard will guide pou through:
Installing the Active’Spne program on this computer
Setting up pour mobile device
Mate: It iz strongly recommendad that you exit all Windows
programs befare continuing with thiz setup wizard.

Click Mext to continue with the setup process. Click Cancel
ko quit zetup.

< Back I Mext = I Cancel | Help |

9 A new window will open to select the installation folder. Simply click on NEXT.

10 A new window titled "Get Connected" will open. Do not click on any button in the Get Connected win-
dow yet.

Get Connected

Get Connected

The Get Connected window will
= back automatically update. Do not
click on NEXT.

You cah alzo conhect vour mobilSGgvi
Far mare infarmation, click Help.

Help

Il After the Active Sync Installed window opens, Click OK.

install S

Active Sync Installed!

12 Open MX-3000 Editor.

I3 Plug the USB cable into your computer and then the MX-3000 Remote.

& Universal Remote Control



Getting Started

14 The Get Connected Window will close and then a "Set UP a Partnership" window will open.At this point

you can make two choices. Please read and make sure that you understand both choices before proceed-
ing:

Yes - This will set up a partnership with that particular MX-3000.This is ideal for an end user, as they typi-
cally will not be programming multiple MX-3000's. Every time the same MX-3000 is plugged in, it will auto-
matically establish the connection.

After choosing Yes, a new "Select Number of Partnerships" Window will open. Chose "Yes, | want to syn-
chronize with only this computer” and then click NEXT.

A "Select Synchronization Settings" Window will open. Uncheck all of the boxes as these features do not
pertain to the MX-3000 and then click NEXT.

The “Set Up Complete” window will then open. Click FINISH. A new window will open showing that a
connection to the MX-3000 has been established.

No - This is best for installers, as they will be programming multiple MX-3000's. This is considered a
"Guest" partnership. Each time that the MX-3000 is plugged in, it will open the get connected window and
the programmer will need to click "No" to establish a connection with the MX-3000.

After clicking No, the Microsoft ActiveSync Window will open and show that a "Guest" connection has
been established.

Keep Your Database Up to Date — USE LIVE UPDATE

MX-3000 Editor includes a vast library of IR codes for hundreds of brands and models of A/V components. This data-
base is constantly growing with the inclusion of new devices every month. Keep your software up to date by using
the Live Update feature. Rather than un-installing and re-installing the software, you download updates to the soft-
ware from the internet. Simply follow these steps:

2

Connect to the Internet normally.

Open MX-3000 Editor.

From the Communications Menu, select Live Update.
In the Live Update window, click on Update Now.

Wait for the window to indicate the download is
completed. Close the Window.

Close and re-open MX-3000 Editor.You do not need to
restart Windows.

HOME THEATER MASTER
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4 Windows, Menus, Tools and Definitions

The Programming Window

%2 M%-3000 Editor B[] 3
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Menus and Shortcut buttons for common tasks. The Program Menu activates each task in the correct order.

Tree View of the MX-3000 configuration. Double clicking on any page enables you to quickly display that
page on the simulator view. Right clicking on a device or page activates a context menu.

The MX-3000 Simulate View is used to navigate and to select a button to program, edit or record a macro.
@ The Edit and Label Buttons window is used to control a button’s graphics, text and activation.
IEI The Macro window is used to view and edit macros.

IEI The information bar displays whether your keyboard is cap locked or num locked.

The important thing to remember as you program is that most Windows conventions hold true in MX-3000 Editor.
Explore the program menus. Hover your mouse over most of the buttons and controls and a balloon will appear
with a hint as to purpose. Navigate around the program window and explore a little before you begin programming.

& Universal Remote Control



Windows, Menus, Tools and Definitions

The Menu Bar and the Menus

Like all Windows programs, the menu bar reveals menus of commonly used tasks. Simply click on the menu title and
the menu appears. Move the mouse cursor over the menu choice you wish to select and click.

Configurations for particular clients are saved as .rcc files on your PC.Thus the file menu enables you to open, save

and import all or part of a configuration.

New - Use to start programming a file from scratch.
Open - Use to open a file anywhere on your computer.

Save - If you wish to save your work to the current file.
Save As - If you wish to save a new copy of the current file
with a new file name.

Import - Import Devices from other MX-3000 configurations.
Export - Export Devices from the current configuratiorr
Import Learn IR - Import only the learned IR commands from
another MX-3000 configuration. The learned commands import

to the embedded Learned IR list, where they can be dragged to any button.

User Preference - Opens the Preferences window, where you
can set defaults for this configuration.

Recent Files appear here for you to reopen with a click:

Exit - Use to exit MX-3000 Editor completely:

File Edit “iew Program Page

Mew Chrl+M
Qpen Chrl O
Save Chrl+5
Save As.., Chrl+Al+5
Impork

Expark

Irnpork Learn IR

IUser Preference

Recent Flle 4

Exit Chrl+0)

Once you have “selected” an item in Tree, Page or Simulator View, you can copy and paste, group and ungroup or

move the selected item. The item can be a device, page or button.

Undo - Use to remove the effect of the last action you made.
Redo - If you have used undo, you can cancel with redo:

Cut - Use to copy and delete the item selected.

Copy - Use to copy without deleting.

Paste - Use to paste a new copy of the last item copied.

Paste Action - Use to paste only the action list of a button.

Paste Special I- Use to paste only the image, the text, the position,
the action or the IR ID of the last item copied into another button.
Paste from Clipboard - Use to paste an image you copied from
another windows program into a button’s Before or After position.
Delete - Deletes the selected item completely.

Delete Contents - Deletes only the contents of the selected item.

Edit View Program Page To

IIndo Ckrl+2
Reda Chrl+y
Zuk Chrl4
Copy CErlHiC
Paste

Paske Ackion

Paste Special. .,

Paste From Clipboard
Delete Del
Celete Contents. ..

X~



Windows, Menus, Tools and Definitions

Select All - Selects all the buttons on the currently displayed page.

. . . . Select Al k-4
Select None - Cancels the current selection without selecting anything new.
Seleck Mone
Group - Groups a number of selected buttons into one group arrangement that (ar oup Chri+G
can be moved, copied and pasted as one.You select multiple buttons by holding down Uniaroup Chrl+LI
the shift key, then clicking on as many buttons as you like. Mave Lp List Chri+-Lp
UnGroup - Cancels the grouping of buttons so that each button can be moved Move Diown List Chl+Dn
independently.
Move Up List - Moves a selected page or device up the list in tree view.
Move Down List - Moves a selected page or device down the list in tree view.
View Menu
The workspace inside MX-3000 Editor window can be arranged as you like.
Macro - Opens and closes the Macro window.
Edit & Label Buttons - Opens and closes the Edit & Label Buttons window. View Program Page Tools (
v Macro F3
Simulate Mode - Most useful mode for programming button actions since you w Edit &Label Buttons  F4
can see hard buttons. and the flag.on each button denoting its programming type. v Simulate Made F5
Only one page at a time can be viewed. Paga View Made Fé
Page View Mode - Useful for extensive editing of images. Programming flags are Both Simulated & Pages F7
not visible, multiple pages can be viewed at once and page Zoom controls
zooming in. v Toolbar Fi
v Status Bar F3

Both Simulated and Pages - Allows both views to be active.

Toolbar - Opens and closes the toolbar of shortcut buttons.
Status Bar- Opens and closes the status bar at the bottom of the window.

Program Menu

Many of the Program Menu steps will open a new window in front of the main window. You can exit any of these
windows without making any changes by clicking on the Close button.

I. Create & Name Dev'lces - Open's a new window for creating and naming devices. [Program Page Tods  Commu
You'll need to name a device (a grouping of hard buttons and pages) for every remote

. 1. Create & Mame Devices
control that you are replacing. 2. Craate Button Lavouts
2. Create Button Layouts - Opens a new floating window to select the button 3. Pre-Programmed IR Dakabas
arrangements for each of your devices from the pre-built templates. 4. Learn IR
3. Pre-Programmed IR Database - Opens a new window to test and program IR e T
code sets from the Universal IR database.You can drag an individual code or the entire &, Macro Programming
set of codes. 7 RF Contral

4. Learn IR - Opens a new window for organizing, labeling and learning IR codes.
5. Punch Through - Opens a floating window that enables you to program a button to “punch through” to another
device. Typically used to program Volume Up, Down and Mute to always operate the a/v surround sound receiver.

6. Macro Programming - Opens the Macro window if it was closed. Starts the MACRO recorder if a button was
selected.

7. RF Control - Opens a new window for configuring the MX-3000’s radio control options.

& Universal Remote Control



Windows, Menus, Tools and Definitions
Page Menu Page Tools Communications

Add Mew Page

Add New Page - Add a new page to the selected device (tree view). Add New Button Ins
Add New Button - Add a new button to the displayed page (simulate or page view). Is Hidden Chrl+H
Is Hidden - Make the currently selected button or page hidden from view when in Zoom b
use. If the page or button is already hidden, a checkmark will appear.To make a page or arid b

button visible again, simply select the item, then select Is Hidden, and the checkmark

will disappear making the item visible again.

Zoom - Only useable in Page View mode. The Zoom menu enables you to enlarge the
view of any page by 2x, 3x or 4x.

Grid - Enables you to view, adjust or select a grid as an aid to alignment of your buttons.

Move ko Front  Ckrl+F
Move ko Back Ckrl+6

Move to Front - Moves the currently selected button in front of all other buttons.
Move to Back - Moves the currently selected button in back of all other buttons.

Image Gallery - Opens a window of button art.You can drag buttons from the gallery| Tools Communications Window

to any page. Image Gallery Chrl+1
Sound Gallery - Opens a window of sounds.You can drag sounds onto any button. Sound Gallsry Chrl+
The sound will appear as a macro step in the selected button. Personal CCF Gallery Chrl+P
Personal CCF Gallery - Opens a window that will allow you to open any ccf file. You

Make My IR DE CErl+M
can drag any LEARNED IR command from the Gallery to any button.

Record Timer CEr+T
Make My IR DB - Opens a window that enables you to customize the IR Database so 7

Run Emulatar CErl+R.

that you only see the brands and models you use on your installations.

Record Timer- Opens a window that enables you to specify that any button’s macro can
be automatically issued at a particular time of day (every day, weekly, monthly or only oncej.

Run Emulator - Opens a new window emulating the MX-3000 for testing of navigatiof.
Close the Emulator by right clicking and choosing exit.

Communications Menu

Upload - Get the programming from a remote control and open it in MX-3000 Uplaad Chrl+
Editoras a new file. Once it is uploaded, you can save it, edit it and/or export the Diownload Chrl+
devices in it. Femaote Control Setup
Download - Send the currently open file to the remote control. Time Sync From P
Remote Control Setup - Opens a new window for you to adjust Backlight time-out, Live Update

brightness, volume, low battery warning and pick up sensor.

Time Sync from PC - Sets the MX-3000 internal timer to the clock setting of your, Remate Contral Yersion

PC.

Live Update - If your PC is connected to the internet, clicking Live Update will open a new/window enabling you to
update MX-3000 Editor software with any new database
entries and/or programming improvements.

Remote Control Version - If you are connected to an MX-3000, a new window will open, displaying the OS and
the Program version number. This may be useful to technical support.

X~



Windows, Menus, Tools and Definitions

The window menu is used when in Page View mode to control the many windows you can open at once:

Cascade - This will cascade all open windows from left to right.
Arrange lcons - This will minimize all open windows and arrange the minimizend.ﬂscade
at the bottom of the window from left to right. Arrange Icons
. . ~ Close
Close - This closes the selected window. Close Al
Close All - This closes all Page View windows, but leaves MX-3000 Editor open.
_Help Menu_
Tutorial - This will open a new window with an interactive tutorial, complete with _
. Tukorial Fi1
movies that demonstrate how to program an MX-3000. o i
Go to Website - Click on this after connecting to the Internet to go to the Universal
Remote Control website for more on-line learning resources. / About Mx-3000 Editar

About MX-3000 Editor - This opens a new window displaying the version of MX-3000 Editor installed on your PC.

The Toolbar and Shortcut Buttons

Hover your mouse over the Shortcut buttons, and you will see a pop-up flag displaying the function of the shortcut.
Click on the button to activate it. The most common functions of the menus are displayed on the toolbar.

DS LREX sEmotSngn s 5§ 64|

When you hover the mouse over a shortcut button,
a pop-up flag will display its purpose.

The Simulate View Mode

Opening Simulate View

The Simulate view mode is the center of programming activity. To open this view, go to the View Menu and select
Simulate Mode as shown or press the shortcut key F5.

\iew Program  Page Tools Ot

v Macro F3
v Edit & Label Buttons F4

Simulate Mode

Page Wiew Mode F&

Both Simulated & Pages F7?
v Toolbar Fa
v Status Bar F2

& Universal Remote Control



Windows, Menus, Tools and Definitions
Selecting Buttons in Simulate View

You use the Simulate view to select a button by clicking on it with the mouse. When a button is selected, it has a red

rectangle around it. Once a button is selected, you can move it, copy or cut it, delete it or use the Edit and Label
Buttons window or the Macro window to program it.

The red rectangle indicates that the TV button is selected.

. When you want to switch to a new device, first click on the MAIN button.

| Choose the new device from the MAIN MENU by double clicking on it.
On a real MX-3000, the double click is not necessary. But within MX-3000 Editor
you sometimes will want to select it for editing or macro programming.

| Cycle through the pages of any device by clicking on either of the PAGE buttons.
" Hover your mouse over a button to see the drag and drop flag.

| Click on a button to selectit. A red rectangle will appear around it.

Button Flags in Simulate View Mode

A button with no flag will not do anything when pressed. It is empty and has no programming yet.

== A P flag indicates that the button is programmed with an IR database code. An IR database code can be
n tapped or pressed and held for a sustained burst. Any button (hard or soft) can be programmed with
~ learned codes, except the MAIN and PAGE navigation buttons.

; . An L flag indicates that the button is programmed with a learned IR code. A learned code can be tapped
. or pressed and held for a sustained burst. Any button (hard or soft) can be programmed with learned

=+ codes, except the MAIN and PAGE navigation buttons.

HOME THEATER MASTER
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Windows, Menus, Tools and Definitions

An M flag indicates that the button is programmed with a macro. All buttons can be programmed
CcD with MACROS except the navigation buttons.

—

A PT flag indicates that the button is programmed to “punch through” to another device.

The pop-up flag will appear after you have clicked on one of the buttons on the page.
Thereafter; whenever you move the mouse over a button with a learned or a pre-pro-
grammed IR command in it, a pop-up flag appears, displaying the actual code name.

Tree View

Devices and Pages

Tree View controls what you see in the Simulator or Page view. It serves as the quickest way to navigate (especially
when programming macros) and enables you to cut, copy and delete devices and/or pages via the right click context
menus.

A Page refers only to a group of soft buttons, not to the hard buttons in the same device.
A Device is comprised of up to 255 pages of soft buttons and one set of functions for the hard buttons.

Double click on a device to expand or collapse your view of its pages (or you can single click on the +/-).

=-=3 Devices

. »@ Devi
-3 TU = E;%ﬂes
+-= AUDIOD Collapsed _[F Page1 Expanded
+-i=2 DUD
Eg UCR P&EE
=) CABLE [ElPages
&3 G (& Pagey
-3 REPLAY (] Pages
-3 AUDID

A double click on a page in Tree View will change the SIMULATE view to the selected device and page.

=& Main -]
- .[Z] page1
E‘rﬁ Devices
5.9 T

|z Page2
Page3
-|2| Pages
PageE
&3 AUDIO
Pag|:_|1
.|| Page2
Page3
|| Pagen

The quickest way to
navigate is to keep tree
view expanded, so that
you can double click on
any page to display it in
Simulate view mode.
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Windows, Menus, Tools and Definitions

Right click on MAIN to reveal the Device Context Menu:

Add Mew Page Ins Add New Page enables you to insert an additional page to the MAIN Menu (to a maxi-
Paste Page Chrl+Y mum of 255 pages). The page is inserted as the new last page.

NP Paste Page will paste the last copied page into the MAIN menu.

. , Delete Contents will delete all labels and codes but not the pages.
aols

Tools > Image Replace will open a new window allowing you to browse to a folder
with new images for all of your button graphics. Any image with the same name as the
images in your current configuration will be replaced.

Right click on a device to reveal the Device Context Menu:

Rename enables you to type in a new name for the device.

Rename Fz
Cut will copy the entire device and when pasted will delete the original.
e Chrl+ Copy will copy the entire device without changing the original.
Copy Chr+C Paste will paste the copied or cut device as a completely new device with the same
Paste Chrl+Y
name.
Celete Cel

Delete will delete everything about the selected device.

Delete Contents.., Delete Contents will delete all codes and macros but not the labels, buttons or

Maove Device Up Chrl+Up pages.
Mawe Device Down Chrl+0n Move Device Up moves the device up the list of devices.

Move Device Down moves the device down the list of devices.
Add New Page will insert an additional page to the device (to a maximum of 255).
Paste Page will paste the last copied page into the device.

Add Mew Page Ins
Paste Page (i o

Tools * | Tools > Image Replace will open a new window allowing you to browse to a folder

with new images for this device’s button graphics. Any image with the same name as
the images in the current device will be replaced.

Right click on a page to reveal the Page Context Menu:

Renams Fz
Rename enables you to type in a new name for the page.
out Chrl+X Cut will copy the page and when pasted will delete the original.
Copy Ceri+C Copy will copy the page without changing the original.
Paste CErl+y Paste will paste the page into the selected device.
Delete Del Delete will delete the selected page completely.

Delets Contents... Delete Contents will delete all codes and macros but not the labels, buttons or

Maove Page Up Zerl+LUp page.
Move Page Down  Ctrl-+Dn Move Page Up moves the page up the list of pages.

Move Page Down moves the page down the list of pages.

5= Qs Is Hidden will make the page invisible on the remote control yet still available for

Open Page Enter macro programming.

Open Page will display the page in the Simulate View or the Page View mode (what-
ever was last selected).




Windows, Menus, Tools and Definitions

Page View Mode

Wiew Program  Page Tools Co

The Page view mode is only useful when doing extensive editing of your button layouts. v Macra F3
To open this view, go to the View Menu and select Page View Mode as shown or press ¥ Edit &LabelButtons — F4
the shortcut key F6.

Simulate Mode F5

+ Page
Baoth Simulated & Padjes F7

v Toolbar Fa
Button Layout Editin i v Status Bar Fa

In page view mode, you can have as many pages as you like open at once.The larger your screen, the more pages you
can fit. In the illustration below, you can see many pages open at once as well as opening the Image Gallery.This
greatly speeds copying and pasting of buttons from one page to another and encourages direct comparison.

T MX-3000 Editor
File Edt Wiew Program Page Tools Communications ‘Window Help

DEE{ER X Byt Sndno V. hh S(Gio G4

TY'Pagel ] 3 E|CABLE'Pagel
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3
3
DO -

Image Gallery
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Page5
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MAIN FEMLIS Circuit ALL
MAIN MENLIS/Football lcons
MAIN MENLS/Faatball All
MAIN MEMUS /Robotic lcons
MAIN MENLIS /Fobotic All
MAIN MENLIS/Suede lcons
MAIN MENUS/Suede Al
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MAIN MENLIS/Smoath &1

When you are in page view mode, the Window menu commands are extremely useful:

Cascade - This will cascade all open windows from left to right.

Arrange Icons - This will minimize all open windows and arrange the minimized icons Cascade

at the bottom of the window from left to right. Arrange Icons
Close

Close - This closes the selected window. Close Al

Close All - This closes all Page View windows, but leaves MX-3000 Editor open.

& Universal Remote Control
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The Edit and Label Buttons Window

Migw Program Page Tools O

o The Edit & Label Buttons Window
W Macro F3

v Edit & Label Buttons

If the Edit and Label Buttons Window is closed, reopen it by by pressing F4 or selecting
Edit and Label Buttons from the View Menu. W Simulate Mode F5
Page Wiew Mode F&
Both Simulated & Pages F7?

Editing Button Labels w Toolbar F&

v 3tatus Bar F3
| x
Display Text — Dynamic—————— [~ Yaniable
You must check off this box for * MNone " Dynamic ’7| NEW' I[NDHE] j
the label to be displayed. ~_Buttan IO - |POWER OFF  |RID [274 _ Normal, Date, Time or Page
Uncherk the box ahen you are \EW You can have a button display the
Dizplay Test=v Dizplay Test :
using button art that has text as Sre e ey e Normal Text, the date, the time
& MNomal  Date © Time  Page fd h he b .
part of the image (like the icons : of day or the page the button Is
for VCR, DVD etc.) Wermal Text I Dynamic Text | on via these radio buttons.
Bl7|u|al ==
: N
Normal Text Iﬁ"al Bold j I 12 j \\Dynamic Text
This is the label you see on the ’/IVDFF This is the label you see on the
button before you press it. — button after you press it. MX-
Simply click in the window and 3000 Editor automatically copies
type to change the button label. whatever you typed in the

Normal Text window, but you
can overwrite it by clicking the

Dynamic Text tab.

Color of Text

You can select any color by click- [ R —

ing the Color button, which :F;-'_---
Bold, Italic or Underline opens the Color window. > :::
You can select or combine the TR | o Text| m-‘-
Bold, Italic or Underline styles\ Lo ol e 5 Hedln—‘
with these buttons. Bl syl === l_l_;acus.mcﬂm.s» ] FIS\:I L:,'E: BB.F
Font ok | _canoul | AddtoCuston Caos |
You can select any of the fonts HBC\‘J Font Size
displayed in this pull down list You can select any of the sizes
box. displayed in this pull down list
Normal Text Window box.
Click in the window and type. If Font Preview
you want more than one line, hit You can see a preview of your
return to make a new line. color, style and font settings

here.
HOME THEATER MASTER
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Button Image Control

You can import a BMP, GIF, JPG or animated GIF file from a image editing program (too many to list but one,
Microsoft Paint, is distributed free with Windows, under Accessories in your Start|Programs list). The restrictions are
that the art must be no greater than 24-bit color depth (16.7 million colors), 72dpi, and no larger than the screen
(320 pixels by 240 pixels). Note that if you have already loaded an image into either the Before or the After positions
the button will reject art that is a different size. Both the Before and the After image must be exactly the same pixel
dimensions. If you do not load an image into a button, the button is resizeable anytime (it can only be a rectangle, but
you can change the background color to any color).

— IMAGE
— Befare /0

b ] ]
on the button before you press ~__

~ J
it. -

B_B_ 8440 brp

Before Image After Image

— After £ 1

|ty X

= |

B_< 84w brp
[ _lreeert Before Irmage

Gif Anirnation : I.ﬁ.nimate Always \é
/
——Fasiion And Size

If you import an animated GIF 20 ———————— ~ Width * Height
ﬁzm 17 “84 “ 40

This is the image that will appear This is the image that will appear

as you press it (for as long as you

\

press it). After you stop pressing

the button, it will return to the

Before Image.

Invert Before Image

Animation Controls “~As a shortcut you can opt to

simply invert all the colors of the

file you can override the default before image after the button is

animation settings with this list
box. If you choose Animate
Once, the animation will loop
one time. If you choose Animate
Always, the animation will loop
forever. If you choose Animate

Default, the animation will loop

Position and Size
You can type in new XY position
for a button and you can resize a

button without images by typing

pressed. Note that text is not
inverted, it simply defaults to

white.

— [MAGE \
—Before /0

After 1

in a new size. If you have import-

for the number of times you ed an image the width and height

specified in your image editing boxes cannot be changed.

program.

il e | s X

peal

24bit bitrnap. brap

v I

Button Image Import and Export

Import Image

Click on this button to browse
your computer for a graphic you
would like to import.

TS

FHH

Export Image

Click on this button to browse
your computer and save the
existing image as a file anywhere

on your PC.

Delete Image
Click on this button to delete

the currently loaded image.

Background Color

Click on this button to open the
color window and pick a color
for a rectangular button without

art.

& Universal Remote Control
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Advanced Applications - Variables and Dynamic O

tions Enable “Displa

Variables offer many additional programming possibilities to the imaginative programmer. There are several ways to
utilize variables, one of which is by assigning a variable to a button. When you assign a variable to it and when the
push of another button sets the variable to |, the dynamic button will react by displaying it’'s After image for as long
as the specified variable stays set to |.When you set a button to be dynamic, any other button can ALIAS to it (see
Macro recording on the next page) and trigger the dynamic button into displaying both its after image and its dynam-
ic text. The dynamic button will pulse or flash its After image and text as long as the macro written to the dynamic
button lasts (you can program delays as you like). This makes lots of interesting “display” buttons possible.

Dynamic Control

Normally, keep the None radio
button selected. When you make
a button Dynamic, it is possible
to make the button flash its
AFTER graphic and dynamic text
by aliasing to it from another
button. The dynamic button will
continue to flash the AFTER
graphic as long as the macro pro-
grammed in the dynamic button

lasts.

Button ID

This is not the button label. The
button ID is editable however.
The button ID is the label you
will see in the ALIAS window
when recording macros. If you
like, you can make a button easi-
er to find by editing the Button

ID to a more unique name.

Diynamic
= Mone { Dynamic

Button |D ; IE'DWEH OFF IR IC

— TEXT
Dizplay fext—v Display Text
’75' Mgfmal " Date

i Time  Pa

Morfial Text I Diynarnic: T ext I

/olz|v|p ==

| &aial Bold

=]

IIIIFF

~ IMAGE

—Before /0

i/t K] e

—After /1

/it K| e

B_B_ 8440 brp

B_ < Bdwxd0 brop
[~ Invert Befare Image

Gif Animation | Animate Always =l
— Pozition &nd Size
WY wiidth * Height
ﬁzm “ |17 “84 * |40
HOME THEATER MASTER
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Variable

If you would like to make a but-
ton dynamically change to its
AFTER graphic when a variable
changes to |, select the Variable

in the list box.

New Variable

If you haven’t named a variable
yet, click on NEW to name it.
The NEW Variable window also
enables you to delete variables

that are no longer needed.

IRID

This is not editable, except by
dragging and dropping a new IR
database code to this button.The
IR ID assigns codes from the
database to this button when you
choose to SAVE ALL of the

codes from a code set.
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The Macro/Favorite Window

Opening Macro Window wiews Program  Page  Tools

Menu.

v [Macro X
If the Macro Window is closed, reopen it by hitting F3 or selecting Macro from the View Edit & Label Buttons ~ F4

v Simulate Mode F5
Page YWiew Mode Fi
Bokth Simulated & Pages F7

The Macro Step Buttons v Toolbar F&

o8|

v Stakus Bar F9

You must select the first step you want played back first, then connect the remote to the PC.
All steps after the selected step will play back, including any delays.

Starts the macro recording process. This enables you to simply navigate to any page
and simply click on a button to create an ALIAS to it. An “alias” is a copy of the but-
ton’s command.

Stops the recording of macro steps

Opens the Delay window so that you can specify a delay in between macro steps.

Enables you to jump to any PAGE of any DEVICE at the end of a MACRO.

Opens a Sound Window for you to select a sound as a macro step. Program a delay at the
same time as the Macro step to enable another sound to play after the first.

Opens a Text Window to type in text that will appear on the button as a macro step.
Program a delay at the same time as the text to determine how long the new text will stay
on the button.You can have as many text steps as you like (to the maximum of 255).

SET VARIABLE Opens the Set Variable window, which enables you to pick an already-created variable and set it

E
IR DATA

&
H \

IMPORT

¢Z¢ SLEEP TIMER

to 0, | or to simply Invert its status as a macro step. If you want to create a variable, you must
click on NEWV at the top of the Edit & Label Buttons window to open the new variable window.

Opens the IR Data window, which allows you to insert an IR command as a macro step
without aliasing to it. This is slower than programming an alias, but has the advantage
that you can control the IR commands burst length inside the macro, enabling sustained
bursts of power on for projectors, or long busts of volume down at the end of a turn
on macro. See Using the IR Data Window on page XX.

You must select the button you want the macro imported to, click on the Import

button, then click on the button containing the macro you want copied. All of the

macro steps are inserted into the new button in one step. Make any changes you want

to the new macro, it is independent of the original (the original is not affected by any

changes you make, nor is the copy affected by changes you make in the original).
Insert this as the first step of a power off macro. Label the button SLEEP TIMER. Each time the
user presses the button, the MX-3000 displays “Go to Sleep in 90 Minutes”, the next press it dis-
plays “Go to Sleep in 60 Minutes”, next it displays “Go to Sleep in 30 Minutes”, then “Go to
Sleep in |5 Minutes” and finally “Cancel”.Whenever the Sleep Timer runs out, the macro you
programmed will be issued (unless the user hits the cancel display).

& Universal Remote Control
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Macro Mode Buttons

Every button has the potential to do two different macros based on either a variable changing, or how long the user
presses the button. Play with these three Macro Mode buttons to get used to them.When you change from one
mode to another, the Option bar changes its display. When the Option bar displays, you have the ability to program

two different macros on one button as follows:

x

[2 @ n ¥ O * =3 6[E| 7 |er <t i
> 4

7/~ \

A ump |

| Aliaz | Delay

Sound | Text

| W ar | IR Data

JTY

DA sec

BICD[0)AUDI0/Pagel)

OREREEERERERA
L i B ) B S A )

B :MP Powering On

B Tadaway

Dptinnw

W &M Ppower

L TivOP1_OM

2

-

In normal mode, the macro window displays no options in the option bar. When you change to Press Time
Mode or Variable Mode, the option bar displays options as shown below.

o NORMAL MODE

In normal mode, the macro will be issued every time the button is pressed.

| £ PRESS MODE In Press Time mode, the button can have two different macros. A unique macro will be issued
if the button is pressed less than the specified time (Before Option). A different macro will be
issued if the button is held down more than the specified time (After Option).When pro-
gramming the two macros, you switch between the two by using the Option bar at the far

right of the Macro window.

— O ption
i~ Before -
When you click on After, the macro window _—
displays the After Macro. e il L
2 =|Sec =

VARIABLE MODE
&

When you click on Before, the macro win-
dow displays the Before Macro.

When you set the time in the list box, you
specify how long the user has to press the
button to get the After macro.

In Variable mode, the button can have two different macros. A unique macro will be
issued if the button is pressed when the specified variable is “0” (0 Option). A differ-

ent macro will be issued if the button is pressed when the specified variable is “|” (|
Option). When programming the two macros, you switch between the two by using
the Option bar at the far right of the Macro window.

When you click on 0, the macro window

— Optian

displays the 0 Macro.

When you click on NEW, the Variable /
Manager opens and you can create a
new variable.

@01

ME W

[Mone] = I<

Ak Ppower
D Dpower
TivoPower

When you click on 1, the macro window
— displays the 1 Macro that will be issued if
the specified variable is 1.

When you select a variable in the list box,
you specify the variable that determines
which macro is sent.

HOME THEATER MASTER

Entertainment Made Simple



8

Windows, Menus, Tools and Definitions

Using the ‘“Spreadsheet” Macro Window

Other Home Theater Master remotes utilize a conventional macro list to program macros. However, the MX-3000
enables you to program macros with some types of macro steps occurring at exactly the same time as others.
Because of this, the macro window is in the style of a spread sheet. At the top of the window, the first step is listed,
then each row below represents the next group of steps.As you can see, in one row, only one step occurs, while in
other rows, many steps may happen simultaneously.

"5 e m % O » == o 45| 7| 2 % 6B

| Aliaz | Dielay | Jurnp | Saund | Tenxt | ar | IR Data | Option
1 BPOWER ON[O]TV/Page]
2 D 2.00 sec BTadaway WTY Powering On ¥ T power
4 BVIDEOD [0][TV/Page?)
O

In this example, the first step is to issue the Power On command to a TV.The next row has four steps occurring at the same
time; a delay of 2 seconds, a sound is playing, the text on the button is changing and a variable is being set to a new value (see
using variables to track power on page xx).After the 2 second delay, the TV’s input is changed. So six macro steps occured in 3
time intervals (represented by the rows numbered |, 2, 3 etc.).

What is an Alias?

An alias is a macro step that in one step refers to the entire macro programmed in another button. If only one com-
mand is programmed in the other button, then the macro step will only perform that command. However, if the
other button has a macro, the entire secondary macro will be played back as one step in the new macro. Thus, the
Alias feature not only saves memory (since it is not copying the IR commands, only pointing to them), but enables
you to program macros nested inside other macros. See advanced programming on page XX for some examples.

Two Ways to Record ALIASES

There are two ways to record macros.When you have many steps to record, the fastest method is to use the
Record button, then click on pages in an expanded tree view to display them, then click on the button you would like
to add as a step. Continue to navigate and click on buttons to record the macro.

When you just want to add one step to a macro you may prefer to use the Alias window. Select the button you
would like to add a step to, then simply double click in the column labeled Alias (click on the row you would like the
new step to be placed).

x_@" ¥ O T =3

| Aliaz | By simply double clicking on the “cell”

1 BrowER OM[O)TY /Pagel) you want to add an ALIAS to, the Alias
2 window will be opened (without pressing

5 record first).
-

B/IDED [0])[TY/Page

The Alias window allows you to browse all of the pages and devices in your configuration, but requires more mouse
clicks than normal macro recording most of the time. If your tree view is collapsed, then the Alias window is probably
a little faster to use, since you don’t have to press the Record button to add a step.

& Universal Remote Control



Type in Section Title |
The Alias Window

0 Main -
) Devices
0T
) Pagel
0 T¥P1_Background
o1
(R POWER OM (- By simply double clicking on each dot,
0 TvP1_GUIDE you expand the tree, until you open the
i) PREY page you want.When you double click on
) POWER OFF the button ID of the button you want, the
03 Alias window will close and the new step
0z will appear in the macro window.
07
0 E
o 9 hd
Delete | F. | Cancel |

Recording Other Types of Macro Steps

For any other kind of step (other than Aliases), you do not have to click on record. Simply select the button you
want to add a step to, then either double click under the column you want to open the appropriate window (Text,
Variable, Sound, Delays, Jumps etc.) or click on the shortcut button in the macro toolbar.

Re-Arranging the Macro Step

You can drag any macro step to a new position by clicking and dragging.

Deleting any Macro Step

You can delete any macro step by selecting it first, then hitting the Delete key on your keyboard.

Tip - You can resize the Macro window b
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The RF Control Window

If the RF Control Window is closed, reopen it by clicking on the Y| shortcut button on the toolbar or selecting RF
control from the Program Menu (Step 7).

Overview of Basic RF Options

Using the basic RF Control Window you can modify the RF properties of an MX-3000 as follows:

I Signal from the Remote can be set to IR only, RF only or both IR and RF. The factory default is set to
both IR & RF.

2 Receiver - If you have multiple MRF-250’s in the system, you can select which receiver a device will be
connected to. The factory default is set to Default.

3 Flashers - You can choose which of the emitter ports a device is connected to. This is vital when your
system includes some identical components using the same IR code set. If you are installing a typical system
with an assortment of unique components using different IR codes, you can leave the Flashers set to the
factory default selection of ALL, however if operation is intermittent try routing to one flasher only.

T - x ; : - i
= Set each device’s basic RF properties by clicking on the
LESice:: | | | | row and column you want.When you do, a combo box will
Device Signal Receiver Flashers . . . . . .
AN RERE | Defoctt Al display the choices available. Click on the option you want:
AUDIO IR& RF  Default All
cD IR& RF  Default All Cancel |
DVD IR & RF Default All Device Signal
TAPE IR& RF  Default All
TIVO IR&RF  Default All IR & RF =
v IR& RF  Default All IR
YCR1 IR& AF  Default All
YCR2 IR& RF  Default All RF
SAT IR& RF  Default All
CABLE IR& RF | Default All IR & RF
Receivers > |

Overview of Receiver RF Options

By clicking on the RECEIVERS button in the bottom right corner, you can extend the RF control window to display
settings for the MRF-250s in your system. In the extended window you have the following options:

I Add Button - If you have more than one MRF-250 base station, add and give each new receiver a unique
name in the window that appears.

2 Rename Button - Before using the Rename button, you must click and select a receiver in the column
under Name, then click on the Rename button.

3 Receiver ID - To prevent all receivers from receiving RF commands, you may opt to set a unique ID# to
each.This is only useful when identical components are installed in different locations. If your system has
an asssortment of unique components using different IR code sets, you may leave the receiver ID # set to
the factory default of ID I.

4 IR Blaster - Each receiver has a built in IR blaster, useful when you have more than six components to be
controlled. If you don’t have any use for this, turn it off, since it may issue too much IR for nearby components.

Receivers:

Receiver ID | IR Blaster Add

Rename

Delete

Fl

& Universal Remote Control



Windows, Menus, Tools and Definitions

The Universal Browser Window S
If the Universal Browser Window is closed, reopen it by clicking on the . shortcut button on the toolbar.

Using the Universal Browser Window you can import LEARNED IR codes from a .ccf file. You cannot import gener-
ated RCS5, Database or generated NEC codes, only LEARNED codes. The browser works as follows:

I Click on the File icon to navigate to the folder that contains the .ccf file.

i

2 Use Tree View to Navigate to the Panel
containing LEARNED IR codes you want. Universal Browser - Plasma Nec.ccf |
'}

3 Click on the panel name in Tree View to

make the panel appear in Panel View. Tree Yiew: Parel Yiew:

. . . [=]- Home
4 Click on a button in Panel View and T 3 %
the Action List view will reveal whether "HOME ( |"."|EI"II..IH"II ‘ Oon/ th

it has Learned Data or not. Only buttons E‘ Devices [ —d

with Learned Data can be transferred. =l Plasma

i Properties
{ Format) Display

Action Lisk:

NMacros
Learned Data

5 Click and hold the left mouse button
to drag a button with learned data

to any programmable button on the
MX-3000 in Simulate View Mode.

SN v

6 When you release the mouse, the blue
indicating a Learned IR command is
displayed on the simulate view of the
button.

()
]
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Programming Overview

Programming Overview

A. New File, Existing File on PC or in Remote

NEW - Starting from scratch on a new job, go to the File Menu, choose New from the File Menu and pick
the type of template you would like to use to program with. None of the templates have any IR codes, just
prelabeled empty devices. It’s just personal preference whether you rename a list of devices or create new
ones in an empty configuration.

OPEN - Open a configuration that you have worked on before and saved onto the PC hard drive.

UPLOAD - Get a file from a client’s remote control that another installer created. Now, you can save the
file on your laptop, make any edits or changes as the client requests or the jobsite requires.

B. Use SAVE AS

The templates files are simply configuration files that have been preprogrammed for you. They will keep any changes
you make. Utilize Save As to make a new file with a new file name. All configuration files are saved with the file
extension .rcc; all device files are also saved with the extension .rcc (see D. Save and Export, below).

TIP — Always use File | Save As to rename the file before doing an

Use the customer’s name and a rev # (i.e. SmithTheaterRev|.mxf)

C. Use the Program Menu

. The Program Menu is your lifeline to a fast, easy programming experience. Follow the
Program FPage Tools (Communics . X . ]
steps in the order shown in the Menu for best results. Typically, you will download to

1. Create & hlame Devices the remote control several times throughout this process and test what you have
2. Create Bukbton Layouts , ol .
3 Prop PHE done so far.You’ll need to download after finishing all programming. For macro play-
4' Lre_ r?p?ramme AL pack to work, you need to have downloaded. These downloads are not listed in the

« LEArn . .

steps here in the Program Menu and are not automatically done for you.

5. Punch Through
&. Macro Programmin - .
5 Cnntrnllg ? It is important that you do all of the tasks for each step before moving on to the next

step. Keep this manual handy so that you can verify that you have completed all of
your tasks.

D. Save and Export

Archive and save your customer files. In addition, you can export devices as .rcc files. Programming systems with simi-
lar components gets even faster when you don’t have to redo your work over and over. You have your own ideas
about what buttons should be labeled and how they should be arranged. You'll save all of your work in a unique and
time saving way by exporting the device stand alone. That way, you can import just the device in any new configuration.

E. Download to both Remote Controls

For once, you have a pre-printed summary sheet and an instruction manual for the entire Home Theater! Enjoy a
brief training with your client and get home on time tonight!

& Universal Remote Control
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Selecting a Template

The first step for any configuration is to choose the basic template of animated artwork.There are ten templates cre-
ated for you in the Samples folder (C:/Program Files/Universal Remote/MX3000 Editor/Samples). The procedure is:

. Select OPEN from the File Menu.
'2 Navigate to the Samples folder (C:/Program Files/Universal Remote/MX3000 Editor/Samples).

'3 Select one of the following ten animated templates.

@ EpTET TED

Aliens
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. ety
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Creating, Naming and Arranging Devices

Creating, Naming and Arranging Devices

A device is the basic grouping of a set of hard buttons and up to 255 soft button pages. You will need one device
group for each remote control that the MX-3000 is replacing. You can have a maximum of 255 devices in your
configuration.When you create devices in the Create and Name Devices window, every device is automatically linked
with a jump-link to the device via the MAIN MENU. If you create devices manually you have to create a jump link
from the MAIN menu button to each device manually, however you have better control over graphics.

Open the Create and Name Devices Window

You can open the Create and Name Devices window by clicking on the first item of the Program Menu or by clicking
on the Toolbar icon as shown here.

Program Page Tools Communications ‘Wwin = EE =gq* @

1. Create & Mame Devices Chrl+1
2, Create Butkon Layouks Ckrl+-2 Lreate & Mame Devices

3. Pre-Programmed IR Database Ckrl+3

label identifies it!

Creating Devices

I Click on the grey button you would like to create a new device in or delete all the grey buttons and drag
in some icons from the lcon display:

Createg&:Name Devices

x

Mext Menu |

Delste |
Save |

L Cee | You must NAME the device to create it. First
select the button that will represent the new
device (either drag it in or select an existing
button), then click in the NAME window and
type the new name for the device.

Page - | Page 1 || Page + |

Select Ican After you have named the device, click on

_ SAVE.
S e &- y

< | il

2 You must NAME the device to create it in TREE VIEW, simply dragging the button does nothing but add a
button to the MAIN page.

3 You must hit the SAVE button to create all the new devices.

4 Once you have finished, you can simply click on Next Menu at the top of the window.

HOME THEATER MASTER
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Creating, Naming and Arranging Devices Manually

5 TreeView reveals the new devices you've created and the simulator shows the new MAIN page one with
all the new buttons displayed.

T MX-3000 Editor

File Edit Wew Program Page Tools Communications ‘Window Help

B R L AT

[ Untitled File I J
B Hain

- [ rage1
£.%g pevices
& TU
(-3 AUDIO
[#-&3 DUD
(-3 SAT
[#-&=0 UCR
(=) CABLE
[#-&3 €D
B
B
[
#
B

DY PAMIC EMNTERTAIMNMENT SYSTEM

o3 AUX
1.=) TAPE
H-= TIVD
=3 WEB-TU
H-=3 LIGHT

'6 Try the simulate view mode out now. If you click once a MAIN MENU button, you'll simply select the but-
ton, if you double click you will jump-link to the device group. Once at the new device group, you can
touch the MAIN button to return to the MAIN MENU, etc.

Creating, Naming and Arranging Devices Manually in Tree View

. Select Devices in Tree View

B Mx-3000 Editor

File Edit Wiew Program Page T

= = R

= Untitled File
+-=3 Main

_eg m

2 Press the Insert key on your keyboard. Each time you press it, a new device is created.

#-= Main

E‘rﬂ Devices
=3 Device1
=1 Device?2
=) Device3d
=1 Devicel
=) Deviceb
=1 Deviceh
=) Device?
=) Device8
=) Device?

& Universal Remote Control



Creating, Naming and Arranging Devices Manually

'3 Select the first device and press the F2 key to name it.

= Untitled File
-2 Hain

El‘lﬁ Devices
R=veuiceill

=1 Deyice?
=1 Device3d

"4 Type in a new name and hit enter.

'5 Repeat steps 3 and 4 untill all your devices are named.

16 Right Click on MAIN in tree view.

= Untitled File -
$ D Add MNew Page Ins
Paste Page Chrl+Y
Delete Contents. ..
Tools r

'7 From the context menu choose Add New Page.

'8 Double click on the new page in tree view to display it on either Simulate or Page view.

'9 Open the Image Gallery by clicking on the shortcut button &-[ or select Image Gallery from the Tools

Menu.

'9 Navigate to the MAIN MENUS by using the scroll bar and click on different MAIN MENUS until you see

the style you like.

Image Gallery x|

tAaIN MENUS /Football &l
kdlk MEMUS /Robotic lcons
tAaIN MENUS /Robatic &l
tdlk MEMUS /Suede lcons
AN MENUS /Suede Al
FAdlb FEM IS /S moath lcons

fAdI N MEMNUS /5 mooth &l
Smooth/Buttanzl
Smooth/Buttonz2
Smooth/Transport]

Open |
Cloze |

-

Use the scroll bar to navigate
to the various MAIN Menus in
the Image Gallery.

HOME THEATER MASTER
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Creating, Naming and Arranging Devices Manually

10 Pick one of the MAIN MENU ALL groups and click and drag the displayed group of buttons to the MAIN
page | display (either Simulate or Page View Mode, we are showing page view mode below).

E Main‘Pagel

15 /Foatball A1
15 /Robatic lcons

AN MENUS /Suede [cons
AN MEMUS /Suede Al
AN MENUS /Smooth lcons
bAAIN MEMUS /S mooth Al
Smooth/Buttonz]
Smooth/Buttonz2
Sroath/Tranzpart]

You don't have to drag a whole group from the gallery, you can choose to pick a background first,
then drag any icon or button over. It is personal preference.

Il Arrange the buttons as you like, then select each of them in turn and uncheck the Display Text box if

needed.
o
Dynami Wariabl
(“ e ‘® Byas [ﬂl tore] =] When icons are dragged from the gallery,
f#‘;}'% the text labels need to be turned off by
Display Tex v el . .
| @ hemd € Ds € Tmo € Pogo unchecking the Display Text check box.
Normal Text | Dynamic Text |
3l7jug ===
rial Bold I3 | EE |
CWD
~IMAGE
Before /0 After 1
e XE | X
7 W/
e T o

12 Program a jump to the appropriate device in each of the buttons.

13 When you are finished save your work by selecting Save from the File Menu or by using the keyboard
shortcut Control|S.

& Universal Remote Control



Create Button Layouts 2!

Create Button Layouts

Although you can manually create your own artwork in an image editing application for every button and arrange the
buttons in any way you want, it is not practical for most custom installation jobs. Thus, MX-3000 Editor is equipped
with many choices for different clients in automatically configured button layouts.

Open the Create Button Layouts Window

You can open the Create Button Layouts window by clicking on the item #2 of the Program Menu or by clicking on
the Toolbar icon as shown here.

Program Fage Tools Communications i

ooo

't = |
Create Button Lavouts

1. Create & Mame Devices Chrl+1
2, Create Button Layouts h
3, Pre-Programmed IR Databi

Selecting Button Layouts

"I Select the device you would like to create a layout for in the left hand column.

Create Button Layout

[x

Frew Menu |
Mext Menu |

'2 Now select the Template for the type of device it is.
'3 In the Skin window, click on the different skins available and they will be displayed in the preview window.
"4 Click on the Overwrite button to replace your existing pages. Click on Add to add to the existing pages.

5 Repeat for all of your devices.When you are finished click on close or Next Menu.

HOME THEATER MASTER
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Using the IR Database

Using the IR Database

Discrete Codes, Toggles and other New Words

The Home Theater Master database is unique in the industry because it includes “secret” discrete codes that are not
on the actual remote controls for many components. These codes are highly sought after by professional installers
because they make automation of the home theater possible via reliable macros! Here are the facts you need to
know:

Discrete Commands versus Toggle Commands

When a remote control’s only button to turn on and off a TV set is labeled Power, it is usually a “toggle” command.
Test it by pressing the button twice. If the power button turns on the TV, then turns it off, it is a toggle command.
That is a big problem when you are programming macros! If you program a macro for watching TV with a toggle,
then the macro is essentially point and pray (if the TV was off, it will turn on, if it was already on, it will turn off). On
the other hand, if a macro is programmed with a discrete Power ON command, the macro will work every time (if
the TV was off, it will turn on, if it was already on, it will stay on).

So the term “discrete command” or “discrete code” means that the code will only do ONE THING to a component.
For example:

A single “Input” command is a toggle type command if it simply changes the input to another input when issued,
while separate buttons for Antenna A, Antenna B, Ext [, Ext 2 and Ext 3 are discrete input commands if, when issued,
the TV goes directly to the named input (and if you give the same command again, it stays on the selected input).

Here are some important facts about Discrete commands:

“Secret” Discrete Codes exist for some components. Why are they secret? Because the manufacturer
wants the remote control that accompanies the component to have the simplest appearance (fewest buttons). Since
toggles reduce the number of buttons, they make the remote control appear easier to operate. Many manufacturers
understand the needs of custom installers and build their components to also respond to discrete codes. They
distribute the discrete codes via service remotes, etc. For the first time, those codes are collected and integrated
into our database.

Not all components respond to the discrete codes in the Database. A component has to be BUILT to
respond to discrete codes. The fact that other models from the same manufacturer do respond to discrete codes

is the reason the codes are added to a code set. However, some models will not respond, because the manufacturer
did not build it to respond through budgetary considerations, time constraints or a simple oversight.

Selecting a Code Set from the Database

I Open the Database Window - Select IR Database from the Program Menu or the Toolbar.

Prograrn Page  Tools  Communications — Win 5 @ m T_, |EI

. 1, Create & Mame Devices Zkrl+1
2, Create Bukton Layouts Chrl+2

Pre-Programmed IR Database

3, Pre-Programmed IR Database Chrl+3

4 1 aze~ TO held

2 Select the Device - Selecting the device you'd like to add codes to from the first list box.

& Universal Remote Control



Type in Section Title

2 Category - Select the type or category of component (i.e. TV, VCR or DVD player).

3 Brand - Select the company that made the component (i.e. B & K, Sony, Krell)

4 Model - Select the Model or the Code Set number (sometimes the actual model, sometimes a generic #
assigned by us to a code set that operates many models over the years).

The device you
would like to add

Pre-Programmed IR Database

* Preprogrammed

Device :

X
Prew benu |

" MylRDE  Leamed
Enter Setup Mumber :

coves 0 —

The category of -

codes.

The brand of the
manufacturer.

The model number of the device.

NOTE: Many models are controlled
by generic code sets listed as Sony
1, Sony 2 etc. Beneath the listed
models, every brand will have a few
generic code sets. If you don't see

your model number, try each of these

Mewt benu
=] | e |

IR Drata from Functian ; Test I
IDVD | | PowER 21 Savelre I:cu:lel
Erand - FOWER

rand PLAY Save all |
FROSCAM -

RO Allstar Cose |
SakSUMG

SAaMSUI REW:<

SaMY0 FafDz

SHaRP E ML

DISP

SN -

LTI P RIS —I CLEAR —
bdodel ; LEFT

ChP-CEOOD [FIMT-D1E;| RIGHT

ChP-HS 700 LIF

SLW-D100 (RMTA501) DWW

SLW-D300P[RRT a0

Sania-Da00 (RM-PPI0 0

SOMY 1 1

2
[SOMY 3] 9 ;I

until you find the right one.

5 Test any Code

A.Verify the MX-3000 is charged and connect it to the PC via the USB port.

B. Point the connected MX-3000 so that it is in range and within line of sight of the component.
C. Select the code you want to test from the function list.

D. Click on the Test button as shown above.

6 Once you find the correct code, you can Save All the codes with one click by clicking on the Save All but-
ton, or you can drag and drop any single code to any button.

7 Continue with the rest of the devices you need, using the Device list box).
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Testing and Preparing for Learning

Testing

In most home theater systems, you will find that some codes have to be learned. You may have a brand new
component whose codes are not yet in the Universal Database or you may have most of the codes for a
component, but a few are missing. To find out what you’ll need to learn, you must rigorously test all of the codes
you have programmed using the IR Database and correctly label the buttons that have to be learned. Of course
you can simply test a button and if it doesn’t work, go into learn mode, test the command, relearn as necessary
and so on. However, this wastes time. The best approach is to download, test all the commands, make a list, then
use MX-3000 Editor to modify labels, and delete unnecessary codes.

Downloading to TEST Pre-Programmed IR Commmands From The Database

When you choose Download from the File Menu or click on the Download button on the Toolbar, the Download
window appears unless you haven’t saved the file. If you haven’t saved the file yet, you will be prompted to do so.

Preparing the List of Buttons to be Learned

|| Test ALL Buttons
Begin testing the codes you downloaded to the MX Remote Controls. Make sure that you test all
buttons (hard buttons and the LCD buttons on each page or every device). Don’t try to learn new
commands yet, wait until you can do all of them at once systematically.

2 Make a List of all buttons that don’t work.

3. Compare the original remote control to the button layouts you've created. Rename anybutton from
missing functions that need to be learned to the List. If you need to add pages, simply right click on the
device and choose Add Page. If you need more button layouts, open the Image Gallery.

A hidden page is accessible during programming so you can teach commands to buttons on hidden pages and use
them in macros. The interesting thing about hidden pages is that the end user cannot manually access the page
using the PAGE button. You HIDE pages using the HIDE checkbox which appears in the Page Menu or by right
clicking on a page in tree view.

Tip - You can still program a Macro to jump to a HIDDEN page for special purposes!

& Universal Remote Control
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Learning Tips
Start with the remote controls an inch apart. The origi-
nal remote points at the back of the MX-3000.Vary the
learning distance from one inch to as much as four feet

if the code doesn’t test correctly.

Fresh Batteries in the Original Remote Control - Weak batteries will cause MX-3000 Editor to fail to
correctly learn. Note that EVEN if the original remote still operates the component, the batteries can be
too weak to produce a strong enough carrier for any learning remote control to detect!!!! When a code fails,
replace the batteries FIRST!

Tap instead of Pressing and Holding - With some codes, this will produce better results. Normally, you
should press and hold.

The “Flutter” Technique - If you are having problems with a Code that has to be sustained (like volume
up or down), sometimes fluttering the button while in learn mode will reduce errors.

The “Semaphore” Technique - Use a book or another opaque object in between the two remotes. Press
the button on the original remote, then remove the obstruction for a moment, then put it back. Experiment
with different timings.

Learning IR Codes One at a Time

I Select the Button - Select the button that you want to teach to by single clicking it.

2 Click on the LEARN Shortcut Button or choose Learn from the Program Menu- The Learn IR
window opens.

3 Click on the LEARN button at the bottom of the Learn IR window to open the LEARNING
window.

— Current Ldgned IR List ;
IR utton Path | Capt

Delete

Test

i

Save

1| o
¢ 1-Lean { 2-Lean Mext Button Learn
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3 The Learn Window opens, Wait for READY to Appear - The MX-3000 must be connected to the PC. Once

you see the Irst Learning READY indicator, press and hold the corresponding button on the original
remote control while pointing it at the BOTTOM of the MX-3000.

Button Caption :

IF'L.-'l‘-.Y Skig

[rata Label : Cancel

Sory OWDE PLAY

Status

1zt Learming Ready. .. :I

[~

4 When the code is successfully learned, the window will say GOOD, confirming that the code learned “cor-
rectly”” Actually, the GOOD means that the code might be good....You need to test it. Select the code in
the Current Learned IR List, then click on the test button. \

\— Current Learned IR List ;

N\ - AN Delete

Buttaon Path |Eaptiu:un \\
STV S Y Devices/Sony .. PLAY

Test

Save

b

al | »]

* 1-Leamn { 2-Lean Mext Buth:-nl Leam |

5 If the code doesn’t operate the component you can try the DoubleTap learning method. This is particularly
useful for components using the Philips RC5 ‘togglebit” protocol. Many high end audio companies use
these codes. Just click on the 2-Learn radio button and you will be prompted to learn every code twice.

— Current Learned IR List :

IR | Buttaon Path | Caption

Test

Save

i

@ |

/v
" 1-Leamn * 2-Leamn Ne:-ctEuttu:-nl Lﬁn |
y 3

/

6 Click on SAVE - You must click on SAVE to save the LEARNED command.

& Universal Remote Control
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Learning a Batch of Buttons Efficiently

Tip - Find the correct “learning distance” using single code learning before
beginning batch learning.

"I Select the STARTING Button - Select the button that is the top left of the buttons you want to teach to.
When learning a batch of hard buttons, MX-3000 Editor starts at the VOL up, moves down the hard but-
tons on the left, then goes to the top right hard button. When learning soft buttons, MX-3000 Editorstarts
at the top left, moves across each row, then moves down.

'2 Select NEXT BUTTON button before you press LEARN - The combination activates the batch
learning capability of MXEdjtor.

L« | ]

& 1-Lean  2- Learn‘NEHt Euttu:unl Learn |

'3 Watch the LEARNING Window - When the info window says READY, press and hold the button on
the
original remote control. When it says GOOD, release the button. During batch learning, MX-3000
Editorautomatically saves and then reselects the next button. When you see that a new button has been
selected and the LEARNING window says READY, then teach the corresponding button on the original
remote control. This greatly speeds the learning process.

a button in the automatic sequence, simply click on the SKIP button.

'4 You can opt to test any code by selecting it in the Currently Learned IR list. If it doesn’t work, delete it
before saving or relearning.

— Current Learned IR List ;
Delete |
IR | Buttar Path | ca
All the codes TV MAST.. Devices/TVAOL+ WV Test |
you learn appear MAST... Devices/TVAOL- W S ave
in the Current TW_PRES.. Devicez/TW/CH+ C
Learned IR list. TV _PRES.. Devices/TW/CH- C—
TW_MUTE Devices/ TV MUTE b
TW_IMFO Devices/ TV AMFO ]l
1| | 3
* 1-Leamn { 2-Lean INE:-:t Button Learr “
[

|

/

5 Save the Codes you've batch learned by pressing the SAVE button. All the codes are transferred to the top
Embedded IR list. The buttons you taught commands to now show the blue L icon in Simulate View mode.

OME THEATER MASTER
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Y3 Advanced IR Code Manipulation

Advanced IR Code Manipulation

o Carrier Frequency in a Learned Command

I Open the LEARN window and select the command that is buggy in the Embedded IR List. Adjust the carri-
er frequency to the correct frequency here.

|
—Embedded IR List Preyw Menu |
L Upis {a | | Devices/REPLAY /Pagel AT Mext benu |
L TivaP1_ENT:1.
L
Test |
L TivOP1_ 912
L TivaP1_ 811 Cloge |
L 1rvor1_7:10
L TivOP1_E:9
L TivOP1 &3
I o imrma a - ll
Enter the Label af IR : ITIUDF‘1_D B Delete |
Frequency : %
—_ - r‘\‘:‘

Note: Typically the reason that the carrier was not detected correctly was because of low batteries in
the original remote control at the time of learning.

Creatin

I Select the button with the code you would like to adjust. Many projectors require a two to four second
burst to power on or off.

2 In the Macro window, double click on the command (learned or pre-programmed) to open the IR Data

window.
IR Dat .
Adjust the number of repeats and test
A the code. With some brands, a two
Current IF; - [TIVOP1_0 Test | second burst might be 18 repeats, with
Fepeat m -] < another two seconds might be 50
o . _ repeats. You have to use trial and error
G Sl ulile o s plessed to find out how many repeats you
Embedded IR List : £ need.
L POWER OFF:32 P
L POWER ON:30 i
L PRESET -29 M —— If you no longer want the button to
L PRESET ;-28 D repeat while it is pressed and held,
L RTURN:- 71 = | uncheck the Repeat checkbox.
L Ta4PE:44
L 1ivoP1_+10:23
L TSIEE If you would like to access another IR
[y LI | command, click on the Expand button.

Delete | I—I':'K Cancel | You can then select a command from

any database or learned code.
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Importing and Exporting Devices 3

Importing and Exporting Devices

Save your work so that it can be easily used on other jobs with the same components.You can just save files by cus-
tomer name, but a better approach is to export devices one at a time. That way you can import just the device you
want in another job, complete with all your artwork, button layouts, labeling, and macro programming.

Tip - Name your EXPORTED device files by Category, Manufacturer & the Model #.

Exporting Step by Step

File Edit “ew Program Page

. From the File Menu choose Export. Mew Chrl-HM
Cpen Ckr|+10
Save Chrl+5
Save fs.., Chrl+alk+3
Imnpork

Impork Learn lg

'2 When the Export window opens, check off the device you want to export.
Export
| ]

Devices | Cancel I
O

Ozuoio

Oovo

Ovcr

O caeLE

Oco
[ REFLAY

. Click on the Browse button to open a browser window. Select the file destination and name the file
according to the Category, Manufacturer and Model.

"4 Click on the SAVE button in the Browser window.You now return to the Export window.You have not
saved the file until you press the OK button.

HOME THEATER MASTER
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'8 Importing and Exporting Devices

Importing Step by Step

I From the File Menu choose Import.The Import window appears.

Import |
| _| Apply |

Devices | | Cloze I

2 Click on the Browse button (...) to open a browser window. Navigate to the folder you keep your
devices and select it.

2l x|

Loak, in: Il.i' My Remate Contrals j ' =5 ER-

’ tesk,roc

File name: |WH Tido 8900, rco Open

Files of type: IHen'n:u::-:nn files [*rec) | Cancel |

Z

3 Click on the Open button and you are returned to the Import window.

4 From the list of devices, select the one you want by checking the check box, then clicking on Apply. The
new device appears in Tree View.You can repeat as many times as you like.

& Universal Remote Control
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Macro Programming

What is a Macro?

A macro is a recording of a sequence of commands that is played back when the user presses a single button. A
macro can have up to 255 steps. A step can be:

ALIAS- Any IR command or Macro on any button on any device.

Delay - Adjustable delay between steps of .| and 99.9 seconds. Longer delays can be created by using
more than one delay. If a delay is programmed as the first step in a Macro, the macro will not be issued
until the button is pressed and held for the specified amount of time.

Jump - As the last step in a Macro, you can specify a jump to any page of any device. You can program
another jump in the macro to display a page with status feedback messages or animations.

Sound - Any step can have a sound WAV file programmed. However, to program a second sound file in
the same macro (so that there is a beep at the beginning and a “tada” at the end of a macro), you must
program a delay in between the two sounds as long as the first sound or longer.

Text - Any step can make the button label change. If you want the label to stay changed, insert a delay
after the text step to keep the text on for enough time for your client to read it.

SET VARIABLE  Opens the SetVariable window, which enables you to pick an already-created variable
and set it to 0, | or to simply Invert its status as a macro step. If you want to create a
variable, you must click on NEWV at the top of the Edit & Label Buttons window to
open the new variable window.

IR DATA Opens the IR Data window, which allows you to insert an IR command as a macro step with-
out aliasing to it. This is slower than programming an alias, but has the advantage that you can con-
trol the IR commands burst length inside the macro, enabling sustained bursts of power on for pro-
jectors, or long busts of volume down at the end of a turn on macro. See Using the IR Data
Window on page XX.

IMPORT You must select the button you want the macro imported to, click on the Import button, then
click on the button containing the macro you want copied. All of the macro steps are inserted
into the new button in one step. Make any changes you want to the new macro, it is independent
of the original (the original is not affected by any changes you make, nor is the copy affected by
changes you make in the original).

SLEEP TIMER Insert this as the first step of a power off macro. Label the button SLEEP TIMER. Each
time the user presses the button, the MX-3000 displays “Go to Sleep in 90 Minutes”, the
next press it displays “Go to Sleep in 60 Minutes”, next it displays “Go to Sleep in 30
Minutes”, then “Go to Sleep in |5 Minutes” and finally “Cancel”’.Whenever the Sleep
Timer runs out, the macro you programmed will be issued (unless the user hits the can-
cel display).

€
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Macro Programming
Discrete IR Codes vs Toggle IR Codes

Manufacturers program their products to respond to IR codes with one action or many:

Toggle - More than one action can occur when the code is sent by a remote control. An example is a POWER
button. The manufacturer programs the TV to respond to a POWER command by turning it on if it was off and
turning off if it was on. So one button can do two things. This requires that the user “know” or “see” that the
television is on or off before pressing the button.

Another example is a television with an “INPUT” command. When the code is issued, the television changes its
input. Since the television has 5 inputs, the single “INPUT” command can have five different results, depending on
what input was previously selected. The user has to “know” or “see” what input was previously selected before
deciding how many times to push the INPUT button.

Discrete - Only one action can occur when the code is sent by a remote control. An example is a television with
a POWER ON button and a POWER OFF button. If the television is already on, the POWER ON command has no
effect. If the television is off, the POWER ON command will turn on the television. Another example is a television
with five discrete input commands (ANT A, ANT B, EXT |, EXT 2 and EXT 3). No matter what input was previously
selected, any of these commands will change the television to the desired input WITHOUT the end user “knowing”
or “seeing” what the previously selected input was!

bonents have “discrete” codes on their original remotes, check the IR Database!

Toggle Commands create ‘“Point & Pray’’ Macros

Imagine a system with three components (a TV, a2 VCR and a surround sound Receiver). Each has a toggle type
POWER command on the original remote control. You program a macro with the three power commands on the
MAIN Power ON button and tell your client to turn on their system with this button. Here’s what will happen:

The client will pick out a videotape and insert it in the VCR (the VCR will now automatically turn on).The client sits
down, picks up their MX remote control and presses the MAIN Power On button. The three toggle type power com-
mands are issued. So, since the TV and the Receiver were Off, they turn on, however the VCR was already on from
inserting the tape, so it turns off. The client is puzzled that they don’t see a picture, so they press the MAIN Power
On button again. The three toggle type power commands are issued again. This time the TV and the Receiver turn off
and the VCR turns on.The client begins to get frustrated...

TIP - For systems with lots of toggle Power codes, create a ‘“Power”’ help list.

You cannot successfully train a family to use a Point & Pray macro. It is too inconsistent. You are
better off creating a help list device named “POWER.” On the Power Page |, create shortcut

buttons to all of the components toggle power commands. Train the customer to turn on the system
by pressing the Power button on MAIN, then turning anything that they need on one at a time. Once
the system is on, they press MAIN and decide what they want to watch or listen to.

Professional Installations Require “Bullet-Proof” (Reliable) Macros or a help list. The use of Point &
Pray macros will create service calls and a lot of bad will. Never leave a customer with a remote
programmed to “maybe” work...

& Universal Remote Control



Macro Programming

Finding Workarounds for Toggle Commands in Macros

By creatively experimenting you may find that you can workaround the lack of discrete codes. This takes time and
there is no guarantee that you will find a workaround for any given component. Here are some common examples:

DVD and VCR Power Workaround
Most DVD players will turn on when off when they receive a Play command. Thus you can workaround like this:

DVD ON = I) Play
2) DVD Stop

TV scrolling “INPUT” Workarounds

Many televisions respond to a channel up or a channel number command by changing to the Antenna input regardless
of what input was last selected. This creates an “anchor” action that puts the television in a known input. Thus you
can create a workaround as follows:

EXAMPLE - CH Up takes TV to the ANT A input (and the TV has 5 inputs -Ant A,Ant B, EXT I, EXT2 and EXT3)

TV to EXT3 = 1) Ch Up (takes TV to ANT A regardless of what input was last selected)
2) Input (takes TV to next input - ANT B)
3) Input (takes TV to next input - EXT 1)
4) Input (takes TV to next input - EXT 2)
5) Input (takes TV to desired input - EXT 3)
EXAMPLE 2 - Any channel number and ENTER takes TV to the ANT A input (and the TV has 5 inputs -Ant A,Ant B, EXTI,
EXT2 and EXT3)

TV to EXT3 = 1)*0”
2)“2”
3) “Enter” (takes TV to ANT A)
2) Input (takes TV to next input - ANT B)
3) Input (takes TV to next input - EXT 1)
4) Input (takes TV to next input - EXT 2)
5) Input (takes TV to desired input - EXT 3)

Programming a Power On Macro

Set up your laptop and the connected remote within operational range of the home theater system while
programming the Power On macro. Power On macros usually require extensive testing of delays and you can
expect to do a lot of experimenting while programming.

I Select the System Power On button on the MAIN page.

2 Click on the RECORD icon

3 Take a look at the MAIN page (both pages if you have two MAIN pages). Decide which components you
want to power on. Start adding their Power On commands to the list by navigating to the device and page
where the codes are located and clicking on the buttons with the Power On commands. Select the device
by clicking its button on the MAIN menu or by clicking on an expanded tree view page.

HOME THEATER MASTER
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4 Now, click on the button with the device’s Power On command.

The new step appears in the Macro spread sheet:

2 e m ¥ O * 38 8| Z| e ct @i
|.-’-'-.Iias | Dielay | Jurnp | Sound | T ext | " ar | IR Dz
1 BTNOPT_ON[O)REPLSY /Pagel]
2 BPOWER OFF[0)TY /Pagel]
3 BPOWER ON[0)&UDI0Pagel]
4  BPOWER[DDWD/Pagel]
-

4 Once you have all of your Power On commands in the list, re-arrange them as desired by clicking and
dragging them into whatever order you want.

5 Ask the client what they think they will watch most often (TV, satellite, DVD, etc.). Program steps to select
the correct TV and Receiver input for that activity. In this example, both the television and the receiver
have discrete input codes and the client’s favored activity is watching Satellite.

Select the RCVR by clicking its button on the MAIN menu. Now, click on the button with the SAT input
command. The new step appears in the list.

6 Select the TV by clicking its button on the MAIN menu. Now, click on the button with the correct input
command. The new step appears in the list. Press the Stop button to stop recording ALIASES.

7 OPTIONAL - Program a jump to the Device and Page they use for their favorite activity.
Click on the JUMP icon. Select the correct device and page from the Jump window. The jump appears in
the Macro window in the column under Jump.

=
=
=3

o n ¥ O[¢] & == 4H | #| e <t bh

| Aliaz | Delay | Jump | Sound | Text | " ar | IR D
B TIvOP1_ON[O)IREPLAY Pagel)
BrPOWwWER OFF[0) T/ Pagel]
B POwWER OMN[D)& D10 Pagel)
B ProvwWER[DDYD Pagel]
B Tv[0)aUDI0Pagel]
BTV T /Page?)

BIREFLEY /Page]

EEEREREE
==l 0 M e O O

8 First, turn the TV and the Receiver to the wrong input, then turn off everything in the theater. Point the
connected MX-3000 at the system. Select the first step in the list by clicking on it. Now, click on the TEST

=

=" button. Observe the television and the receiver. Did they both switch to the correct input?

9 Programming additional delay in the macro is sometimes necessary. Each macro step usually takes some
time, so there may be enough built in delay for the television and the receiver to both be fully active by
the time the input commands are sent. Sometimes the component is not fully awake. It is fashionable for
many modern televisions and receivers to require 5 or more seconds of warm up time before they are
responsive to new commands. In a case like that, you will need to add more delay between steps.

& Universal Remote Control



Type in Section Title

10 Select the Delay icon

Now, click on the preset amount of delay or enter any time between .| second and 30 seconds in the
“Customize” window.

Enter Delay Time : |01 -

— Quick Select
01 zec " 2zec 10 zec
 05zec " 3zec " Bl zec
= 1 sec  Bzec 939 zec

Delete | k. I Cancel |

Il The new step appears in the list. Now, drag the delay step to the correct location.

12 Again, turn the TV and the Receiver to the wrong input, then turn off everything in the theater. Point the
connected MX-3000 at the system. Select the first step in the list by clicking on it. Now, click on the TEST
button. Observe the television and the receiver. Did they both switch to the correct input? Continue to
revise the macro with delays or changes in order and test until the macro ALWAYS correctly turns every-
thing on and switches the surround sound receiver and television to the correct input.

When the macro is perfect, click on the SAVE in the File Menu.
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Macro Programming

scramming a Power Off Macro

A Power Off macro is much simpler than a Power On macro, since there are rarely any delays to test, etc. Usually, to
give the client some feedback that the macro is working, the TV is turned off first.

L)
=

TR E R

| Alias | Drelay | Jump | Sound | Text | " ar | IR Drata |

1 BPOWER OFF[O)TY/Fagel]
-

When you are forced to “workaround” a DVD player or VCR without a discrete off command, you will make the
macro more reliable if you place the time consuming anchor (the play command) at the beginning of the macro.

Make sure that you turn the DVD player off before testing this kind of workaround. You are testing the worst case,
you know that a toggle type power command will turn the DVD player off if it is ON, you are concerned about what
will happen if the DVD player is already off, when the client presses the MAIN Power Off to turn everything else off.
If you only programmed a toggle Power command, everything else would turn off, but the DVD player would turn on.
This “workaround” ensures that the DVD player turns off.

o Activity Macros on MAIN LCD “Device’” Buttons

An Activity Macro is typically programmed to be as fast as possible. They simply select the correct input on both the
television and the surround sound receiver, since all the components have already been powered on by the Power
On macro.

There is no need to program a JUMP to a page in a MAIN “Device” button created by Create and Name

Devices.They are automatically programmed to JUMP to the Device.
Sometimes activity macros will share the same input settings. Here,a DVD player doubles as a CD player. The
programmer has copied the DVD device, named it CD, so that there are two identical devices (with the same DVD
player IR codes). The only difference between them is the Activity Macros you see below. The DVD Activity Macro
selects THX Surround Sound with 5 speakers with the TV on, while the CD Activity selects Stereo with 4 speakers
and forces the TV off. For components that have play commands it is typically ok to have a “Play” command in the
macro.Watch out for components with toggle type play/pause buttons. That kind of “Play/Pause” command should
not be placed in an Activity Macro without a preceding “Stop” command, to make sure that the toggle can only play
the component!

One DVD Player - Two Devices and Two Activity Macros

DVD Activity Macro CD Activity Macro
I Alias | Dielay I Alias | Dielay
1 1
2 BDYDJAUDI0Page) 2 BDYDIAUDI0Pagel)
3 BTHA[O0)AUDI0Page?) 3 BSTER[O)ALIDIOPaged)
4 BPLAY [0)DVD/Pagel] 4 BPLAY [0)DVD/Pagel]
O- O -

Note how the programmer is using the same DVD input on the surround sound receiver for both activities, the
macro simply changes the surround sound settings.

TIP - Don’t OVERAUTOMATE, make sure that every step is truly useful!
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Macro Programming 4!

You can often speed programming by instantly inserting all of the steps of a previously programmed macro as the
starting point of a new macro.The inserted steps are completely editable, without changing the original macro.

I Do not start recording at the new location. Simply select the button where you would like the macro
inserted. Then click on the IMPORT button.

2 Navigate to the device and page where the original macro is programmed. Click on the button that
contains the macro. During navigation, you might click on a device button which happens to contain a
macro. A popup window will appear asking if you want to insert this macro. Answer NO if you are simply
using the device button to navigate. Answer YES if you want this macro copied/cloned/inserted.

3 When you click on the button that contains the original macro, all of the steps are copied/cloned into the
new button location and the Simulate view jumps back to the new button’s device and page.

4 Edit as needed and click on SAVE.
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Punch Through

Programming Punch Through

MX-3000 Editor enables you to quickly set up common functions on all devices for the hard buttons. Usually used
only for Volume Up, Down and Mute; however, you may find it convenient to punch through to the satellite Menu
controls and the Channel UP and Down.

I Open the Punch Through window by clicking on the shortcut button in the toolbar or by selecting
Punch Through from the Program Menu.

2 Select the devices which you want to change programming by clicking on them
while holding down the CONTROL key on the keyboard. If you want them all
selected (normal for Volume Up, Down and Mute), simply click on the Select All
button. Any device you select will be HIGHLIGHTED in the “Punch To” list.

ﬂ
Purich Ta: Funch From : Frew benu |
[Main] ~ Type
:||r|
Chanel : MI
I[N one] j S ave |
Yolurme, Mute : Cloze |
M avigation :
I[N one] j %
Selectall | Clearall |

3 Select the device that has the codes you want used in the Punch From list.

4 Click on SAVE. Check the devices you programmed, you should see the red PT (Punch Through) flag on
every button affected on all the devices you programmed:

TV VCRI MAIN

5 Repeat for any other groups of codes as you like.
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RF Control

Programming RF Control Options

The RF Setup Window

The RF Setup window opens after selecting RFControl from the Program Menu or

clicking on the shortcut button.

1. Create & Mame Devices
. Creake Butbon Layouks
. Pre-Programmed IR Database

. Learn IR

[ 3 (R S G R

Adjusting

. Punch Through
. Macro Progranming

Program Page  Tools

Communications W

Ctrl+1
Chrl+2
Ctrl+3
Chrl+4
Chrl+-5
Crl+6

The RF Setup window enables you to adjust the properties of RF Control by clicking on the intersection of a row and a column
and then selecting from the pull down list box the property you want. All of your devices are displayed. You can set each device
individually to be controlled by clicking on the cell you want to change. After clicking, a list box of options will appear.

SIGNAL controls how the MX-3000 will send commands:

IR and RF - Both RF signals and IR commands

are sent from the MX3000. The RF E .
. . . Dewices:
signals will also be issued as IR com-

| IR Output |

mands by the MRF-250.

IR - Only IR commands are sent from
the MX3000, as a result the MRF-
250 does not send any commands.

RF - Only RF signals are sent from the
MX3000, as a result only IR com-
mands from the MRF-250 are
received by the device.

Receve i you 1 sl s 1250 —

receiver will receive the commands for this
device.Thus, you can send commands to a device
in another location via a second MRF-250 placed
in that location (up to 16 in one house).

Note: In a system with only one MRF-250 receiv-
er, this does not need to be adjusted.

\

Receiver

Signal |

5.0 All
All
All
All
All
All
All
All
All
All
All

Default

«=TN)

Devices:
Device | Signal | Receiver | Flashers
Equipment Closet All
Equipment Closet All
Equipment Closet All
Equipment Closet All
Equipment Closet All
Equipment Closet All
TV's Line 1

Equipment Closet

Receivers » |

HOME THEATER MASTER
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RF Control

IR OUTPUT controls the Line Outputs for
Flashers affixed to the front panels of compo-
nents.You can opt to either send IR Commands
to:

ALL - The commands are sent to all of
the Flashers

1-6 - Just the specified Flasher receives
the IR commands (Useful when
identical TV’s or VCR’s are utilized
in the system)

Devices:
Device | Signal | Receiver | Flashers
MAIN IR & RF Equipment Closet All
SAT IR & RF Equipment Closet All
DVD IR & RF Equipment Closet All
TIVO IR & RF Equipment Closet All
YCR1 IR & RF Equipment Closet All
AUDIO IR & RF Equipment Closet All
V1 IR & RF TV's Line 1
TV? IR & RF TV's Line 2
TV3 IR & RF TV's i
N7 R 2 RF TV's Lined -|
CcD IR & RF Equipment Closet All
Line 1
Line 2
1| Line 3
Line 4

Addin

ID#’s and Front

Blasters

0K

Cancel

i

Receivers >

|

To add a new receiver to the list, to change the Receiver IR# of your existing receiver or to enable/disable the Front Blaster,

click on the Receiver button of the RF Control
window.

After pressing the Receivers button, the RF
Control Window will enlarge revealing the
Receiver configuration options. Again, you click
on a cell to adjust.

The Receiver ID cells enable you to change the
ID# of each receiver, so that commands for one
will be ignored by the other if set to different
ID’s.

Note that in this system, the MRF-250 in the eq
uipment closet is set to ID#2 and the MRF-250 con-
nected to the identical TV’s is set to ID#I.

If you want the Front Blaster turned OFF on
any receiver, reset it by clicking on the correct
CELL and selecting OFF.

NOTE: In some installations, the MRF-250’s
Front Blaster is so powerful that it can overload
nearby components and give poor or intermit-
tent operation. Try re-positioning the MRF-200
to reduce the power flooding the cabinet or turn
the Front Blaster off.

Devices:

Device | Signal | Receiver | Flashers
MAIN IR & RF Eguipment Closet All

SAT IR & RF Eaquipment Closet All

DVD IR & RF Equipment Closet All

TIVO IR & RF Equipment Closet All

YCR1 IR & RF Equipment'Closet All
AUDIO IR & RF Equipment Closet All

V1 IR & RF TV's Line 1
TV? IR & RF TV's Line 2
TV3 IR & RF TV's ine 3
N7 R 2 RF 's Lire 4
CcD IR & RF Equipment Closet All

1| [+
Receivers:

Name ) | Receiver 1D | IR Blzcter |
TV's 1D 1 SEE

IFauinment Closet WP ON =

OFF

Receivers < |

Add
Rename

Delete

i

You may rename a receiver to something

more descriptive by first selecting the

receiver’s name cell, then clicking on the

Rename button.

Enter new name:

Iannstairs

o]

Cancel
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Finishing The Program

Setting Up the MX-3000 Defaults

I Open the Remote Control System Setup
x

window by clicking on the shortcut
button on the toolbar or selecting it - Backlight
from the Communications Menu. On battery pawer : ™ Tum off device if not used for |1I:| seconds ¥ |

. . On the cradle > I Tum off device if not used far |2D seconds 'I
2 Enter the amount of time you would like [%

the backlighting to stay on (after a button — Brightness Level Sound
is pushed) for both settings, on battery

I |
power and on the cradle. ’
L High L High
3 Adjust the brightness and the sound ~ Button Light
volume to your taste.
LED iz
4 Set the backlighting of the hard buttons
in the Button Light section. [ Fower
Lows battery warning at |20 | X
5 Set when the MX-3000 should give a
low battery warning. ~ Pick up

Device will automatically wake up when its angle is channged & ON
6 Set the pickup sensor on or off.

" OFF
7 Save the SEttingS or download them Download to Remaote Control Save Cloze
to test.
Setting Up the MX-3000 User Preferences
I' Open the Preferences window by clicking on ARSI x|
Preference in the File menu. -~ Program
Default Font Aial Bold hi
2 If you would like to change the default font Diefault Macro Fepeat (IR] - IE‘
for your buttons, select it here. ¥ Display IR Info on Toolkop

System File Path

3 If you would like to speed up macros, lower _ _
Image Gallery : IE:'\D ocuments and Settingz\Marc Enc Johhson _l

the Default Macro Repeat. Most components
need only | burst. However some brands Skin : IE:'\Ducuments and Settingz\Marc Eric Johhzon _l
(mOSt nOteabl)’ JVC) reCIUire 3 bursts. B)’ Template : |E:'\Ducuments and Settingsihare Eric Johnsan _l
lowering the default # of repeats, you speed
up your macros dramatically.

—File
4 Ifyouh d llery, ski [e
)’OU ave create your own ga er)’, SKIn or p User Defined I _|

template, you can set it as the default here.

W Use when a Button is pressed

5 Set your default beeps for all buttons. ~\wiite Protection (4digit
. i [~ BCC Passwaord : — Canfim: [
6 If you wish to write protect the system, so A— I—
that no other installer can edit your file, I™ Remote Setup Passward : Confirrn :
enter passwords to both fields.
7 Click on OK to save your settings. Ok, Cancel
HOME THEATER MASTER

Entertainment Made Simple




0

Up and Downloading

Downloading to MX-3000

You download to the remote control by:
I Make sure the remote control has charged batteries.
2 Connect the cable between the PC and the remote control.

3 Verify that the file you have open in MX-3000 Editor is the one you want to download to the remote con-
trol.

4 Click on the Download to Remote Control shortcut button on the toolbar or choose Download from the
Communications Menu. Do not move the mouse or touch the keyboard during the download.

TIP - Make sure that the cable o i pushed all the way in to the connector.

Uploading from the Remote to PC

Uploading is necessary when you arrive at a jobsite with an existing MX-3000 system that you would like to service,
edit or clone. Simply upload the file to your PC, save it with a new file name and you can edit the file, send it to other

remotes, make a touch up and download back into the customer’s remote.

I Make sure the remote control has charged batteries.

2 Connect the cable between the PC and the remote control.

w

Save any work and open a NEW empty file.

4 Click on the Upload from Remote Control shortcut button on the toolbar or choose Upload from the
Communications Menu.

5 When the upload is complete, save the file with a new file name.

& Universal Remote Control



Using MX-3000 Tools

Using MX-3000 Tools

MX-3000 Editor incorporates some useful tools for custom installers who like to organize their work, so that each
new job gets easier than the last.You can create your own custom image or sound galleries and easily switch
between them. You can make a record timer of any macro. Just head up to the Tools Menu and experiment.

Using Make My IR Database

The IR database used for theMX-3000 Editor is huge and contains thousands of brands and models. Sometimes the
size of the database can slow you down as you scroll past all the brands you don’t ever install. You can easily create
your own database of just the brands and models you like by choosing Make My IR Database from the tools menu.

I Select the code sets you need on the left. User IR Database x|

IR Diata from : Selected Maodel :
2 Click on the right facing arrow to transfer a |ALIDID | AUDI0. B & K, AVR307
code set to your IR database. Brand -
3 Continue to work through the database and Eg\SrETDN i
transfer any code set to your database. CARVER
Casio
.- . CHIRD
4 After you have finished, click on OK. CINEM& SOUND =
. . todel :
5 To use your IR database during programming —
simply open the normal Database window from B&K HT Products (1] 3
the Program Menu then choose Use My Database iggg &
on the top radio buttons. REF-20
REF-30 s
Pre-Programmed IR Database &VR-202 |
sT1400-1 j
" Preprogrammed & MylRDE  Leared ELK_Audin Broducts [
Ok I Cancel I

Device : nter Setup Mumber :

Note that the IR Database window also enables you to search the Embedded Learned IR codes and drag them to any
button as easily as you drag an IR database command.

Using The Emulator

Instead of downloading to the remote, you can
check your work with the Emulator. Simply choose S ———
Run Emulator from the Tools Menu and your

current configuration will be loaded and displayed % @ﬁ %
in a real working PC screen mockup.You can test @ @ @

aII' of your nawgatlf)n and check for any problems — >
without downloading to the remote control. @

TAPE

To close the emulator, right click on the emulator
and choose Exit.

If you would like to test the IR codes, right click and
choose IR Test.

If you would like to watch macros, right click and choose show action list.

HOME THEATER MASTER
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Advanced Programming Techniques and Ideas

Push and Hold Macros

Any macro can be programmed so that nothing will happen if the button is simply tapped. You can force the client to
press and hold for any time between .| and 99 seconds to issue a macro. For most clients, this would be a bad idea
since it makes things more difficult and more time consuming. However, here is an application that we think you
might find useful for particular clients:

Push and Hold for Activity Macros and Tap to Switch Devices

If you have a hobbyist client, a power user who is constantly switching devices and making adjustments to different
components, this can improve operation for him/her.

Here’s how this application works:

Program all of the MAIN MENU Activity Macros with the Macro Window in PRESS Mode and the option
bar set to AFTER .This ensures that the client will have to Press and Hold the button to issue the Macro.

With the option bar set to BEFORE, program a jump to the device only.

When the client simply taps a MAIN activity button, he/she simply switches devices.

One Button Issues Two Different Macros

Since you can program 255 steps in either the BEFORE or the AFTER macro, you really have complete freedom to
program anything you can think of.

Status Messages for Impatient Clients with Long Macros

For clients who have problems waiting for long macros to finish, it is helpful to design the system to give a dramatic
status message while the macro is working, otherwise they may put the remote down in the middle of the macro, frus-
trating themselves. All you need to do is create some extra pages and place big buttons with text or graphics or even
animated graphics on each page. Insert jumps to the appropriate pages in your macro and the result is that the client
sees a slide show with your messages on it as the macro plays back.You can do a smaller version, by programming text
in the macro itself, text shows up only on the button, so may not be visible enough for clients

Helping Confused Clients

When do clients get confused? When their system is full of old gear they couldn’t afford to replace! When the
salesmen sell components without discrete codes! When the manufacturer of a cool new product blows it and
incorporates hard to use, but vital features!

In any event, by using MX-3000 Editoryou can often solve some problems very effectively.

TOAD -TV Input “Scrolls” or “Toggle’’ and has no Workaround

When you have a component that is difficult to automate, it helps to call it names (TOAD, for Toggle Only Actuated
Device, has been suggested). Once you have vented your feelings, get out MX-3000 Editor and go to work. There is a
relatively simple way to make operation of a device like this much less confusing. Here’s how to go about it:

& Universal Remote Control



Advanced Programming Techniques and Ideas 5

ole Only Actuated Devices

The key to using this technique is reliable RF communication between the MX-3000 and the MRF-250 base station. If
the MRF-250 is placed carefully, and is getting no RF interference, the variable technique is very reliable.
Fundamentally, you are going to program the MX-3000 to remember that the component is on or off, and only issue
the toggle type Power command when needed. The system can get out of sync if the client turns on the TV with
another remote control or by hand.

"I Create a new device and name it Power Tracking. Add a page to it.

= c:\Documents and
-2 Main

E|‘r2 Devices

-2 TU

+-= AUDIO
[#-i=3 DUD
#-=3 VCR1
-3 CABLE
&

[

=3 CD
=1 REPLAY
2= PowerTrackin

'2 Drag a button from the image gallery onto the page. Label the button for the component. We'll call our
example TVPowerOn.

o C:\Documents and
&3 Main

=-%g Devices

= TU

i-=1 AUDIOD

=2 DUD

B
&
[#-i= UCRA
[
B
&

.= CABLE
=4
7= REPLAY
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Advanced Programming Techniques and Ideas

3  With the TVPowerOn button SELECTED, click on the VARIABLE MODE button.

"2 © m % O = = 4|8 | e g

| Aliaz | Delay | Jump | Sound | Text | War | IR Drata

0 gl el
pEW |
/ —

— Option

4 The Variable Option bar appears.
5 Click on the NEWV button in the Variable Option bar.

6 The Variable Manager window opens up.

¥ariable Manager x|

Hews Wariable: I / | .-’-'-.ppIH\J Delete I Close |

/ / )

7 Type in TVpower and click on Apply, then Close the Variable Manager.

8 Click on Option 0 in the Option bar. Select the variable TVPower from the list box.
9 Program the toggle TV Power command as the only step in the 0 macro.

10 Double click the Set Variable button on the macro toolbar or double click on a cell in the VAR column.
The Variable window will open.

Il Select the TVPower variable from the list and click on the | radio button (in the macro, you just issued the
power command and turned on the tv, so you are setting the variable to | (tv is on). Then click OK.

o0 1 7 |pvert Status

Delete | k. I Cancel

& Universal Remote Control
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Advanced Programming Techniques and Ideas 5!

Click on Option | in the Option bar. Select the variable TVPower from the list box. Don’t program any IR
commands in the Option | macro. It should do nothing.

Save your work, choose Save from the File menu. Now it is time to create a second button, called
TVPowerOFF, repeat steps 8-12 but program the TVs toggle power off command in Option |, then set the
TVPower variable to 0.With this button, you program nothing in Option 0. Save your work.You have just
programmed two discrete commands from a toggle! To implement, simply alias to the TVPowerOn button
in any macro where you want to check that the TV is on, and alias to the TVPOwerOff button when you
want to check that the TV is powered off. The client must be trained to never use any other remote con-
trol or to turn on the TVby hand.

HOME THEATER MASTER
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500 Mamaroneck Avenue
Harrison, NY 10528
Phone: (914) 835-4484
Fax: (914) 835-4532
www.universalremote.com
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